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1 License manager IDEA applications are protected by several protection tools. The valid license is required to run the programs. Remark: Local license on the workstation and Eleckey Network license are software licenses, bound to the computer hardware. The license must be deactivated (returned to the Activation server) before significant hardware changes (hard drive replacement, BIOS flash) and activated again after finishing the changes. The licensing mode setting and license management is performed using License manager (IDEALManager.exe). If the application cannot find the proper license to run, a warning appears and a question to run the License manager is displayed. The License manager can also be run:   



Using Windows command Start > All Programs > IDEA StatiCa > License manager Using command File > License manager in IDEA applications Using command License in the main IDEA StatiCa application



The mode to obtain the license can be set in the Select license type: 



Local key – licenses are stored on the current workstation or on the USB flash disc. If the USB flash disc with licenses is attached, the licenses are taken from the USB only, otherwise the licenses are taken from the workstation. A license file is the integral part of valid license – see 4 License files for software licenses.
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Network key – the licenses for workstations are provided from the Eleckey Network license server. A license file is the integral part of valid license - see 4 License files for software licenses. Network key HASP – the licenses for workstations are provided from network HASP hardware key.



A tab to set parameters of the currently selected licensing mode is available. Click Test licenses to display the list of modules for the currently selected licensing mode.
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2 Local licensing Local licensing mode is the default mode of IDEA applications licensing. The license may be stored on the local workstation or on the USB flash disc. To use local licensing mode select option Local key in the group Select license type in the Licenses manager.



2.1 Activating the license on workstation



To be able to manage the license on the workstation, the Local key tab must be available in the License manager dialog (the USB license key must not be attached). The particular workstation must be connected to the Internet in the moment of activation. 1) Copy Activation key (which you received) into the Activation key edit box in Activation group. Click Activate button beside the Activation key text box. Program connects to the Activation server and license is transferred to the workstation. 2) Copy the received license file into the appropriate directory – see 4 License files for software licenses.



2.2 Transferring license to another computer If it is required to use the program on another workstation or hardware changes, reinstallation of operating system etc. is planned, it is necessary to transfer the license back to the Activation server. Copy the Activation key into the Activation key edit box in the Activation group. Click Deactivate button beside the Activation key text box. Program will connect to the Activation server and license will be transferred back to the Activation server. After transferring the license back to the Activation server, it can be activated on another (or the same) workstation following the steps described above.



2.3 Upgrading license (re-activation) When upgrading the license it is sufficient to copy the updated license file into the appropriate directory – see 4 License files for software licenses. The process of prolongation of time-limited version is similar to the initial activation. After receiving the confirmation that the activation key is ready for reactivation, start the License Manager. 1) Enter Activation key into the Activation key edit box in the Activation group. Click Activate button beside the Activation key text box. Program connects to the Activation server and the existing license is updated (re-activated). 2) Copy the updated license file into the appropriate directory – see 4 License files for software licenses.
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2.4 Upgrading the license on the USB flash (re-activation) To be able to manage the license on the USB flash disc, the USB key tab must be available in the License manager dialog (the USB license key must be attached before launching the License manager).



When upgrading the license it is sufficient to copy the updated license file into the appropriate directory – see 4 License files for software licenses. The process of prolongation of time-limited USB license is similar to the upgrade of the license on the workstation. After receiving announcement that re-activation is enabled, start the License Manager (USB key must be attached to computer). 1) Enter Activation key into the Activation key edit box in the Activation group on the tab USB key. Click Activate button beside the Activation key text box. Program connects to the Activation server and the license on the USB flash disc is updated (re-activated). 2) Copy the updated license file into the appropriate directory – see 4 License files for software licenses directory.
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3 Network license Eleckey For Eleckey network licensing, a Network License Server (NLS) must run on any server in the company network, so the server can provide the individual licenses for the particular workstations. The on-line communication between the workstations and the Network License Server is mandatory when using the Eleckey network protection. It means, that the TCP-port of the Network License Server has to be enabled on the server firewall (default port of Network License server is 1245). The license file must be also present on each workstation.



3.1 Installation on local workstations The IDEA StatiCa must be installed on required workstations. The licensing mode Network key must be set on each workstation in the License manager.



Following properties of the connection to the Eleckey network server can be set on the Network key tab:   



License server host name – the DNS name of computer, where the Eleckey Network License server is running. License server address – the IP address of computer, where the Eleckey Network License server is running. Port – the number of port, on which the Eleckey Network License server service is available. The default port number is 1245.



The properly specified License server address is enough to establish the connection between the workstation and the license server. If both License server address and License server hostname are specified, the IP address resolved using DNS from the host name must match the specified License server address. Next copy the license file into the appropriate directory on each workstation – see 4 License files for software licenses.
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3.2 Network License Server (NLS) The program NetKey License server has to be installed on the computer, which should provide the license service. To enable the licenses on the Network License Server the Activation keys have to be registered on the NLS. The setup of NetKey License server and the license tools are packed in the archive-file NetKeyTools.zip, which can be found in Downloads section of www.idea-rs.com 3.2.1 Setup of the License Server To install the NLS‚ run the ‘NetKey License Server 4.0.exe‘. At the end of setup the license server is started and offers to run NLS as a service or as a GUI-program under the current user account. If the NLS runs as a service, administrator has to stop the service if he wants to run the NLS in GUI mode, otherwise a conflict message of the NLS TCP-ports appears. If the license server is running as service, the GUI version of license server (second instance of network license server) cannot be started (TCPIP port conflict appears). The service must be stopped before launching the GUI version. 3.2.2 Tools for licenses activation Only Activation Keys are used to activate the licenses on the License server or to transfer the licenses to another license server. Tools REGISTER.EXE and TRANSFER.EXE are used to work with licenses on the License Server. The computer, which runs the tools REGISTER.EXE /TRANSFER.EXE, has to be connected to the Internet at the moment when activating/transferring the license. To connect to the Network License server, the tools REGISTER.EXE /TRANSFER.EXE use settings specified in the configuration file NETKEY.INI, which is in the same directory as tools REGISTER.EXE /TRANSFER.EXE. The default setting is Host=localhost – it assumes that tools REGISTER.EXE /TRANSFER.EXE are run on the computer, which runs the NLS. Content of NETKEY.INI file: [Network] ServerAddress= ServerPort=1245 Host= The address of the Network License Server must be specified as an IP-address in the line ServerAddress= or as a computer name in the line Host= . The IP address must be resolvable from the specified computer name using DNS. It is necessary to set the current port number in the line ServerPort= in cases that the Network License Server does not run on the default port (1245). If the tools REGISTER.EXE /TRANSFER.EXE are run on another computer (other than the computer where the NLS has been installed), it is necessary to adapt the settings in the configuration file ‘NETKEY.INI’ – to set the address/name of the computer, where the NLS has been installed. In this case the computer, which runs REGISTER.EXE /TRANSFER.EXE, establishes a connection to the server with the NLS and a second connection to the Activation server (over Internet).
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3.2.3 Registering the license on the Network License server Run the tool ‘Register.exe’. Copy the Activation Key into the edit box Activation key. Click on the Activate button. The tool connects with the Activation server and it activates the license on the NLS.



3.2.4 Transfer of a license to another computer The transfer of a license is done in cases if the administrator has to use another computer as a Network License Server or if the administrator is going to reinstall the operating system on the current computer with NLS. The transfer moves the license back to the Activation server, after which it is possible to re-activate license on the other computer. Run the tool TRANSFER.EXE. Copy the Activation key into the edit box Activation key. Click on the button Deactivate. The tool connects with the Activation server, returns the license to the Activation server and it removes the license from the NLS. If TRANSFER.EXE communicates with NLS where no license is installed, the Deactivate button is not available. There is button Activate available instead and it has the same functionality as button Activate in REGISTER.EXE tool. After transferring the license back to the Activation server, the administrator can re-activate it on another computer following the steps described above. 3.2.5 Upgrading the license When upgrading the license it is sufficient to copy the updated license file into the appropriate directory on each workstation – see 4 License files for software licenses. The process of prolongation of time-limited version is similar to the initial activation. 1) After receiving the confirmation that the activation key is ready for reactivation, run REGISTER.EXE utility, copy yours Activation Key to the Activation key edit box and click Activate to reactivate the license. 2) Copy the updated license file into the appropriate directory on each workstation – see 4 License files for software licenses.
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3.3 Eleckey Network license troubleshooting 3.3.1 Activation troubleshooting  Activation utility REGISTER.EXE /TRANSFER.EXE displays message “Cannot connect to NetKey License server”. Possible reasons: o Service, which provides licenses to the network, does not run on the server – NetKey License server (neither as application, nor as service) o The address/name of computer, which runs NetKey license server, is not specified correctly in NETKEY.INI file (in directory, where utilities REGISTER.EXE /TRANSFER.EXE are stored) o Communication between utilities REGISTER.EXE /TRANSFER.EXE and license server is blocked – the required TCP port is blocked on firewall  Activation utility REGISTER.EXE /TRANSFER.EXE) displays message “Cannot connect to Activation server. Please check your internet connection and try again”. o If this message appears during activation and the internet connection works properly on computer, where REGISTER.EXE/TRANSFER.EXE are run (ping to ‘www3.idears.com’ gets replies), try to run utility REGISTER.EXE (TRANSFER.EXE) on another workstation in the network. File NETKEY.INI has to be adapted in such case (in directory, where utilities REGISTER.EXE /TRANSFER.EXE are stored). Set IP address of computer, which runs NetKey License server, into the row ServerAddress= and adapt row Host= accordingly. The file looks like following: [Network] ServerAddress=192.168.1.2 ServerPort=1245 Host= where 192.168.1.2 is IP of server running NetKey License server. After launching REGISTER.EXE /TRANSFER.EXE the utility runs on workstation and communicates with the NetKey License server on the one side over the local network and with the IDEA Activation server on the second side over the internet. This procedure can be used for remote management of licenses over internet (requires to have the port of NetKey License server to be available from the internet on firewall). 3.3.2 Application on workstations troubleshooting  Application displays message “Cannot connect to NetKey License server”. Possible reasons: o Service, which provides licenses to the network, does not run on the server – NetKey License server (neither as application, nor as service) o The address/name of computer, which runs NetKey license server, is not specified correctly in NETKEY.INI file (in application directory) o Communication between application and the license server is blocked – the required TCP port is blocked on firewall  Application displays message “NetKey: Lincese is required”. Possible reasons: o No licenses were activated on License server.  Application displays message “NetKey: Number of users reached the limit” IDEA RS s. r. o., South Moravian innovation centre, U Vodarny 2a, 616 00 BRNO tel.: +420 - 511 205 263, fax: +420 - 541 143 011, www.idea-rs.cz, www.idea-rs.com







o The maximal number of concurrent users connected to the License server has been reached Application displays message: “NetKey: Invalid key device”. Possible reasons: o The license got corrupt on the Network license server (hardware changed, virtual machine moved to other host). The license must be re-activated.
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4 License files for software licenses



For software licensing (local on workstation, local on USB and network license Eleckey) the license file must be present on the workstation. License file extends an existing and functional software license – see previous chapters. License file name pattern is either IdeaRS_UserID.key or IdeaRS_UserID_CompanyName.key, where:  



UserID - is an identification number of software license (displayed as UserID item after clicking Test Licenses) CompanyName – identifier of license owner company.



License file must be copied:  



either into the license directory C:\ProgramData\IDEARS\License\ - the license file is valid for all installed versions of IDEA StatiCa7 and higher. or into the appropriate installation directory of IDEA StatiCa (default directory is C:\Program Files\IDEA RS\StatiCaX) – license file is valid only for the IDEA StatiCa in this directory.



For network licensing, the license file must be copied into the license directory or installation directory of IDEA StatiCa on each workstation, on which IDEA StatiCa is run. IDEA RS s. r. o., South Moravian innovation centre, U Vodarny 2a, 616 00 BRNO tel.: +420 - 511 205 263, fax: +420 - 541 143 011, www.idea-rs.cz, www.idea-rs.com



License file information is displayed in the License manager on the License file tab.
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5 HASP network license For HASP network licensing the licenses are stored in hardware USB key. The key is plugged in to one of computers in the network (to the license server). The on-line communication between the workstations and the license server is mandatory when using the HASP network protection. It means, that appropriate ports must be open on the computer, where the HASP key is plugged in. The default ports are TCP/UDP 1947.



5.1 Installation on local workstations It is not required to install any drivers on local workstations when working in local network. The IDEA StatiCa must be installed on required workstations. The licensing mode HASP network key must be set on each workstation in the License manager.



If option Show this dialog during application start-up, the License manager is launched before launching IDEAStatiCa.exe to be able to modify the list of required licensed modules. 5.1.1 Selection of required modules Group of modules or individual modules, for which the licenses should be checked out from the license server, can be selected/unselected in the group Modules on the tab Net key HASP. If option Commercial modules is selected, the sets of licensed modules, which corresponds to business model of IDEA StatiCa applications, can be selected. The selected commercial module is transferred to the set of checked out technical modules. The union of required technical modules is created when more of commercial modules are selected. IDEA RS s. r. o., South Moravian innovation centre, U Vodarny 2a, 616 00 BRNO tel.: +420 - 511 205 263, fax: +420 - 541 143 011, www.idea-rs.cz, www.idea-rs.com



If option Technical modules is selected, single modules to check out the license, are selected. 5.1.2 Communication between workstation and license server The HASP USB key is searched in network using broadcast query by default. To get the list of available HASP USB keys of IDEA company and the content of the keys (list of modules and number of available licenses per module) click Find key above the list Found keys. IP address – enter IP address of server, where the HASP USB key is plugged in. The address must be entered, if the workstation is in another network than the license server or the server cannot be found using the broadcast query. If the IP address is specified, the file HASP_108213.INI is created in the directory %USERPROFILE%\APPDATA\LOCAL\SAFENET SENTINEL\SENTINEL LDK The file contains only one item: SERVERADDR = defined address Remark: the application must be re-launched after the change IP address to apply the new content of INI file. The INI file can be created also manually, without setting the IP address in License manager – than the content of INI file may not correspond with the real INI file content.
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5.2 Running the license server 5.2.1 Hardware key drivers If drivers for HASP hardware key are not installed on the computer, where the HASP USB hardware key is plugged in, the drivers must be installed. Either the GUI installation package Sentinel HASP/LDK Windows GUI Run-time Installer or command line installation package Sentinel HASP/LDK Command Line Run-time Installer can be downloaded from the manufacturer web site http://sentinelcustomer.safenet-inc.com/sentineldownloads/ 5.2.2 Sentinel Admin control center The administration interface of the licencing service is available on the computer after installing Sentinel HASP/LDK. To open the web administration interface Sentinel Admin Control Center open the URL http://localhost:1947/ in your browser. The vendor ID of IDEA company hardware keys is 180 213. To display key details (list of modules, connected users etc.) click menu command Options > Features. 5.2.3 Updating the content of HASP hardware USB key The key can be updated using V2C file. After receiving the update V2C file run the Sentinel Admin Control Center on computer, into which the HASP USB key is plugged. Click menu command Options > Update/Attach. Click Select file and then click Apply file to update the content of USB hardware key.
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5.3 HASP network license troubleshooting 5.3.1 Workstation cannot detect network key By default, a broadcast query is used by default to find the server with attached HASP hardware key or INI file created according to specified IP address of license server is used to locate the license server – see 5.1.2 Communication between workstation and license server, thus it is not necessary to install any drives on individual workstations. However, if the broadcast query and the search according to INI file may fail to detect the key (network restrictions, workstation behind the firewall etc.). Then the same hardware key driver package as for server must be installed on the workstation (see 5.2.1 Hardware key drivers). Launch Sentinel Admin Control Center on workstation (use browser URL http://localhost:1947/). Click Configuration in left side menu. On tab Access to remote license managers select option Aggressive search for Remote Licenses and enter the IP address of the server with attached HASP hardware key into the field Specify Search Parameters. After the changes are stored and application is restarted, the key is searched using direct query to specified IP address.
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